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hello! i’m tony!

I’m a digital artist and designer who loves 
to create for brands. The past 14 years I 
have had the please to collaborate with 
Adobe, ABSOLUT Vodka, Dunkin’, and other 
fun brands!

These days I aim to empower aspiring 
creatives through live streams, workshops 
and tutorials so they can create with 
accessible knowledge helping them along 
the way.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/


brush settings
quick-guide
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brush tip shape
•	 Choose the brush shape and default size of the brush.

•	 Adjust angles.

•	 Adjust the Softness and Hardness.

•	 Adjust Spacing to make the brush work as a stamp or continuous stroke.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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shape dynamics
Randomize your brush strokes using size, diameter, angle and roundness. 

The Size Jitter changes the brush size as you create strokes.

The Minimum Diameter sets a minimum size of your brush to keep it from 
getting too thin as you paint. If you set it to 50% the size will never go lower 
than 50% of the selected brush size. So if the size is 100 it will never go
under 50.

Tilt Jitter randomizes your brush tip angle depending on your stylu pen’s tilt 
and is activated when you set the control to pen tilt.

The Angle Jitter changes the angle of the brush tip as you paint. For example, 
if it’s set to 100% it’ll change 360 degrees as you paint.

Roundness Jitter changes the roundness of the brush tip shape as you 
create strokes and use the minimum roundness setting to prevent it from 
being too flat.

Among all settings, you have the Flip X and Y Jitter that flips the brush tip on 
the X or Y axis as you paint.

Brush Projection is a feature for drawing tablets that makes your brush react 
to the pen’s tilt, pressure and rotation movement to mimic drawing with a 
pencil on paper.

brush controls
•	 Fade - Creates a tapered stroke that shrinks to a minimum size over a specified number of steps. 

(Great for when you don’t have a graphic tablet and using a mouse)

•	 Pen Pressure - Controls brush size and/or opacity based on how hard you press.

•	 Pen Tilt - Controls brush size or angle by tilting the pen.

•	 Stylus Wheel Rotation - Uses stylus wheel rotation for brush angle control.

•	 Initial Direction - Makes brush strokes react to the pen’s angle for dynamic width/shape

•	 Direction - Rotates brush shape based on direction its being drawn

 Always make sure the 
checkmark is checked so the 
setting is applied.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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scattering
Scatters the brush shape as you create strokes, great for creating a brush for 
shading or texture.

The Scatter slider scatters on the opposite side of the way you’re painting but 
by checking both axis so the brush scatters in any direction.

Increase the number of the scattered shapes by increasing the Count.

The Count Jitter randomizes the amount of shapes produced with 
each stroke.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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texture
Use default patterns or your own to add texture to your brushes.

After selecting a texture, use the Depth slider to bring out more of the 
texture as needed. Adjust the depth as you adjust the other settings so 
you don’t lose the desired visibility.

Use the Scale slider to decrease or increase texture.

The Brightness slider adjust the brightness while the Contrast slider adjusts 
the contrast of the texture.

Uncheck Texture Each Tip, if you want the the brush to paint the texture 
consistently across the stroke.

Play around with mode! Height is typically the default, so explore  
others to achieve different effects until you find what’s ideal for your brush.

Minimum Depth is the lowest texture visibility your brush will achieve based 
on the Depth setting.

The Depth Jitter increases and decreases the depth of the texture for each 
stroke. For example, 0% for a more unified texture and 100% for more 
varying depths.

Use the Invert checkbox to invert the texture, making whites black 
and vice versa.

create a pattern file (.pat) from photoshop
•	 Create your pattern

•	 Edit > Define Pattern.

•	 Give your pattern a descriptive name and click OK.

•	 Window > Patterns to see your new pattern. (Often highlighted in blue.)

•	 Save as a .PAT File (Using Preset Manager):

•	 Open the Preset Manager (File > Preset Manager, or sometimes within the Patterns Panel menu).

•	 Select the Patterns preset type from the dropdown menu.

•	 Select your newly created pattern(s) in the list.

•	 Click Save Set, choose a location, name your file (name.pat), and save.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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dual brush
Combines 2 different Photoshop brushes together. The selected dual brush 
will be masked by the overall brush shape. Perfect for texture brushes!

After choosing your brush shape, head to the Dual Brush setting, and choose 
any brush there.

While in the Dual Brush setting, select different modes to see how they apply, 
I always prefer to start with multiply.

Check the Flip option to flip and rotate the brush on the X and Y axis 
randomly.

The Size slider will adjust the size of the selected dual brush.

The Spacing slider adjusts the spacing between the dual brush’s texture.

And similar to the Scattering settings, you can adjust the sliders for the 
Scattering and Count to scatter the Dual Brush elements along with 
increasing or decreasing the amount for each stroke.

A trick I like is starting off with a hard round brush, small size, and testing with different stroke 
lengths to get a better idea of what’s going on with the dual brush initially before applying the 
final brush shape.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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color dynamics
Randomizes Hue, Saturation, Brightness, and Purity within brush strokes 
using percentages. Great for creating a more natural look.

The Foreground/Background Jitter allows you to paint with 2 colors at once. 
Adjust the slider to the amount you’ll like to mix the colors.

Use the Hue Jitter to randomize the color of each stroke, the smaller the 
percentage, the closer the stroke’s hue will be to the selected color and the 
higher percentage, the more variation you’ll receive.

The Saturation Jitter works similar and varies the saturation within 
each stroke.

The Brightness Jitter works the same giving each stroke a different 
brightness, lower percentages means less variation and closer to the original, 
and the higher the percentage, the more variation of brightness with brush 
strokes.

The Purity slider controls the overall saturation of the brush overriding the 
Saturation Jitter, for example 0% will give you a gray color no matter what 
color you select and 100%+ will give you full saturation.

Apply Per Tip - Uncheck to apply a new hue with each stroke.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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transfer
Controls dynamics of opacity and flow. Helpful for creating natural buildup of 
color and transparency. 

Opacity Jitter - Adjust the slider to randomize the opacity during different 
areas of the stroke.

Flow Jitter - Randomizes the rate color being laid down, allowing build-
up to full opacity within a single stroke without lifting the pen, perfect for 
rendering and shading.

Wetness Jitter is adjustable when you select the Mixer Brush Tool and adds 
randomness to paint build, flow, and brush angle, making strokes look more 
real mimicking watercolor or oil painting.

Remember, the higher the percentage for the sliders, the more variation in opacity.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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brush pose
When you want to repeat a brush stroke at the same angle, rotation and 
pressure sensitivity.

While in the Brush Pose settings, adjusting Tilt X and Tilt Y will change the 
brush’s angle.

X changes the brush front and back while Y changes the brush left to right.

Rotation, limits the rotation of the brush.

And pressure adjusts the pressure imitating pen pressure you get from a 
graphics tablet and pen.

The most important thing to keep in mind while in these settings is they are 
great when you do not have a graphics tablet but if you do, you can select 
override so your pen will behave like a mouse to keep the strokes uniformed 
and not change when you rotate or tilt your tablet pen.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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noise
Adds subtle noise to brush and helps prevent banding in soft gradients and 
smoother rendering/blending.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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wet edges
Makes edges of brush opaque. Perfect for watercolor brushes.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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build-up
Works like the flow setting to achieve gradual color intensity, from subtle 
hues to solid coverage. Adds depth and textures.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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smoothing
Creates cleaner precise strokes and helps with shaky hands. Great for line 
work or when using a mouse instead of a stylus.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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protect texture
Makes sure a specific texture remains consistent and scaled correctly across 
brushes and strokes. Prevents it from being distorted as you paint or use 
different brush tips keeping it uniform.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/


creating your
custom brush!
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Things to keep in mind...

the purpose of the brush
(Is it for texture, sketching, or special effects?)

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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And always remember...

don’t switch brushes during the process!

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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create your brush shape
Start off in Adobe Photoshop or Illustrator to create the brush shape.

Once you have the shape or pattern ready, give it a layer in Photoshop and 
create a selection of the brush either by holding Command and clicking on the 
layer thumbnail in the layers panel or use the marquee tool around the area.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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define brush
Head to Edit, select Define Brush Preset and give your brush a name.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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customize brush
Open brush settings to customize the brush until it is ideal for
the intended purpose.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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save brush
Select New Brush Preset within the Brush settings panel and name it to make 
it official.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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export brushes as set
Head to the brush panel, select the brushes, click on the gear icon on the top 
right of the panel, Export Selected Brushes and name the set.

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
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thank you!
Always feel free to reach out if you have questions via email (TonyLockhartGraphics@gmail.com)

or social media (@theCreativeSnark)

https://www.instagram.com/thecreativesnark/
https://www.linkedin.com/in/tonylockhart/
https://dribbble.com/thecreativesnark
https://www.thecreativesnark.com/
mailto:TonyLockhartGraphics%40gmail.com?subject=Hello%20Tony%21
https://www.instagram.com/thecreativesnark/

